K:S

Inform

K&S Taiwan Government Uniform Invoice (GUI)

B After installed the “K&S Taiwan Government Uniform Invoice (GUI)” App.
Login to “Accountant” Role Center, you will see the K&S Taiwan Localization Functionality List on it.

Cronus Demo | Finance~~  Journals~~  KSl Journals* KSI Financial Reports~ > | =

Chart of Accounts  Bank Accoy= Tric¥famareUnnd=> Purchase Orders  More v
4 Taiwan Localization Setup

Actions 1 Manual Register GUI I
-+ Sales Credit Memo

GUI List
+ Purchase Credit Memo B *
~+ Payment Journal Entry & print GUI
> Taiwan Localization Setup [ Import GUI from Excel
> Payments
3 Analysw's D, Zero Tax List
> Tasks [ GUI Media File
> Create )
[} e-GUI CSV File
> Reports

[} e-GUI ALW CSV File

Activities ~ [ e-GUI CAN CSV File ,
e =
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Declaration Site Master

1-1. Open the “GUI Declaration Site” Page by clicking “Taiwan Localization Setup>> GUI Declaration

Site”.
Dynamics 365 Business Central Sandbox Q
e T \\
< ( 4 ) + fil] +/Saved 7
K Reminder: your work date is 9/10...  Use to... | Changet... | Turn off remin... v
@3_ GUI Declaration Sita [ Category Code Setup More options

1-2.  Enter your Site Master Information.

Declaration Si_te

X Reminder: your work date is 9/... Use to... | Change t... | Turn off remin... v
¥ Card 3 VAT Posting Setup More options
Uniform
Number Of Taiwan Tax
Site Code t Site Name Site ID

=at 3
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1-3.  Fill in your company Uniform Number in the Site Code field.
(* Taiwan Uniform Number only allow 8 characters.)

Dynamics 365 Business Central

Sandbox Q al

TN
< Declaration Site |:_~ & ):l —+ ] " Saved T
X Reminder: your work date is 9/10/2020  Use today | Change to...| Turn off reminder v
¥ Card 3 VAT Posting Setup More options
Uniform Actived
Number Of Taiwan Tax Declaration
Site Code T Site Name Site ID Period

— (28853916 ¢ KSI 28853916 028853916 10911

1-4.  You must fill in all the fields on this page before opening “Card”.
»  Site Name: Your company name
»  Taiwan Tax ID: Taiwan VAT Register Number (9 characters).

Dynamics 365 Business Central

Sandbox Q al

_/
& Declaration Site |:_~ Vd ):' + [i]

28853910

" Saved —{

X Reminder: your work date is 9/10/2020  Use today | Change to...| Turn off reminder v
¥ Card 3 VAT Posting Setup More options
Uniform Actived
Number Of Taiwan Tax Declaration
Site Code t Site Name Site ID Period

— [28853916 ¢ KSI 28853916 028853916 10911
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1-5.  After finishing the fields, Click the “Card” button to open the Site Master Main Page to continue.
Dynamics 365 Business Central Sandbox Q al o) ? B
|'/.-7-.\\
< Declaration Site [ V7 | — i " Saved T
N
X Reminder: your work date is 9/10/2020  Use today | Change to...| Turn off reminder v
\'\
|E‘ Card 3 VAT Posting Setup More options
Uniform Actived
Number Of Taiwan Tax Declaration
Site Code t Site Name Site ID Period
— |28853916 KsI 28853916 028853916 10911
1-6. Open Site Master Page.
Dynamics 365 Business Central Sandbox Q n} & ? B
|'/. _-.\\
< Declaration Site Master Card [ V7 ) -+ [ v Saved T
N
X Reminder: your work date is 9/10/2020  Use today | Change to... | Turn off reminder ~

2 GUI No. Set & User Authorization

K:S

[af] Upload GUI Stamp

Site Code 28853916

Site Name KSI

General Show less
Uniform Num... 28853916 Declaration Ty... 401 ~
Taiwan Tax ID 028853916 Declaration Pe... 2

Owner Tax Refund Me... v
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1-7.  Fill in the other information for Site Master.
»  Default Site Master: If your company has many declartion site master, you can create more
than one in the system. But the system only allow one Site Master be set to “default”.
& Declaration Site Master Card I/f-\l -+ T " Saved [
N
KX Reminder: your work date is 9/10/2... Use tod... | Change t... | Turn off remind... v
% GUI No. Set & User Authorization [af] Upload GUI Stamp
General Show less
Uniform Num... 28853916 Declaration Ty... 401 w
Taiwan Tax 1D 028853916 Declaration P... 2
Owner Jack Wang Tax Refund M... v
Site Address 10F.No.51, Dongxing F Area Code A ~
Phone Number 87683791 Day of VAT Dec. 15
County Taipei Actived Decla... 10911
7IP Code 11070 Default Site .. (@D
1-8.  Enable user can create the Taiwan GUI on which module process.
2
S Declaration Site Master Card |\f/| —+ T " Saved [

283853910

X Reminder: your work date is 9/10/2...

% GUI No. Set

& User Authorization

Use tod... | Change t... | Turn off remind... v

[af] Upload GUI Stamp

Function

Link Manual ... ‘) Allow Pre-Peri... '(. D

Link APto GUI - - @D e-GUI Print Re... 52144425
Link ARtoGUI - (D Line of e-GUI ... 20
Link Order to ... ‘) e-GUI Remark test

Link Posted O... ‘)

Link ARto Zer... @D Combine (.:)

VAT Bus. Posti... ~ PerMonth ® )
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1-9.  If your company has sales export and you enable the “Link AR to Zero Tax” function, please set up
the “VAT Bus. Posting Group for Zero Tax” configure.

N
S Declaration Site Master Card ( &) 4 Til]

08853916

X Reminder: your work date is 9/10/2...

v Saved T

Use tod... | Change t... | Turn off remind... v

Eﬂ’ GUI No. Set & User Authorization Upload GUI Stamp

Function

Link Manual ... ‘) Allow Pre-Peri... 'C. 3‘

Link AP to GUI [ @) e-GUI Print Re... 52144425
Link ARto GUI - (D Line of e-GUI .. 20
Link Orderto .. @D e-GUI Remark test

Link Posted O... ‘)

Link ARto Zer... @D Combine @ )

VAT Bus. Posti... ‘EXPORT % ‘ PerMonth @ )

1-10. Upload your company GUI Stamp. (It’s optional)

It will show on the “Computer Uniform Invoice report”.

< Declaration Site Master Card ‘/f\l + i

28853916

X Reminder: your work date is 9/10/2...

+Saved [

Use tod... | Change t... | Turn off remind... v

-

1% GUI No. Set & User Authorization ( Upload GUI Stam py‘

Function

Link Manual ... ‘) Allow Pre-Peri... 'C.::'

Link APtoGUI - @D e-GUI Print Re... 52144425
tinkARtoGUI - (D Line of e-GUI ... 20
Link Order to ... ‘) e-GUI Remark test

Link Posted O... ‘)
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1-11. Click “GUI No. Set” to fill in your GUI No. Set which your local National Taxation Bureau assigned to

your company.

- o x
e @ nhttp://d365bc-wl-tw-ks/nav/7bookm O ~ & || @ Edit - Declaration Site Mast...
Dynamics 365 Business Central | 28853916 > 28853916
& DECLARATION SITE MASTER CARD @ - [
Process T Actions Less options
£% GUI No. Set & User Authorization  [&] Upload GUI Stamp 4 VAT Posting Setup -+
Link AP to GUI & GUI Print Summar... Please reference Sales Order
Link AR to GUI & Remark test
Link Order to GUI [ O Combine @
Link Posted Order... [ O PerMonth @
Link AR to Zero-T... [ O]
v

1-12. Click “User Authorization” to set up who has permission to use the “GUI No. Set”.

= ER 9%
e @ http://d365bc-wl-tw-ks/nav/7bookm O ~ € || @ Edit - Declaration Site Mast...
Dynamics 365 Business Central
L DECLARATION SITE MASTER CARD @ e 1]
Process Actions W Less options
t# GUI No. Set & User Authorization [«5] Upload GUI Stamp #* VAT Posting Setup 42
Link AP to GUI [ o] GUI Print Summar... Please reference Sales Order
Link AR to GUI @& Remark test
Link Order to GUI &) Combine @
Link Posted Order... & PerMonth @
Link AR to Zero-T... @D
v
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1-13. Click “VAT Posting Setup” to set up the “GUI Media Type”.

1-14.

e @ http://d365bc-wl-tw-ks/nav/7bookm O ~ &

Business Central

Dynamics 365

& DECLARATION SITE MASTER CARD

28853910

Process Actions

% GUI No. Set & User Authorization

Link AP to GUI

Link AR to GUI

Link Order to GUI

Link Posted Order...

Link AR to Zero-T...

& Edit - Declaration Site Mast...

Less options

8888

[«&] Upload GUI Stamp

i
v

#* VAT Posting Setup

GUI Print Summar...

Remark

Combine

PerMonth

Please reference Sales Order

test

@ >
@ >

Fill in the “GUI MEDIA TYPE” field.
1: Taxable — VAT% is 5 and need to declare VAT report to National Taxation Bureau.

2: Zero-Tax — VAT% is 0 and need to declare Zero Tax List to National Taxation Bureau.

o @ http://d365bec-wl-tw-ks/nav/?boc O ~ & || @ Edit - VAT Posting Setup - D...

Dynamics 365

VAT BUS.
POSTING
GROUP

DOMESTIC
DOMESTIC
DOMESTIC
DOMESTIC

http://d365bc-wi-tw-ks/nav/Zruninframe=1# |

SALES
VAT
ACCO

5610
5610
5610
5611
5610
5611

Business Central

VAT Posting Setup

£ Search -+ New

E% Edit List
RE..

PUR.. CHR

VAT VAT

ACCO ACC

5630

5630

5630

5631

5630

5631

VAT Posting Setup

X Delete

VAT CLAUSE

CODE

ZERO

REDUCED

Please enter value 1,2 or 3 (1:Taxable
2:Zero-Tax 3:No Tax)

Press Ctrl+F1 to learn more

EU
SERV

O

ORO OO

TAX
CATEGORY

"wn i i mMm m
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Vendor Card

2-1.

K:S

Inform

Edit Vendor Card to setup the domestic vendor’s Taiwan Uniform Number information.

Dynamics 365 Business Central

& VENDOR CARD

R
¢) + @

44756404 - Furniture Industries

.

Process Request Approval New Document Actions
Taiwan Localization Setup - GUI

Uniform Number 53740476

GUI Format Code 21

Invoice Title

GUI Deliver Addr.

Deduction Code ‘ 1‘ X

Copyright 2020. Knowledge & Strategy Information Co., Ltd. All rights reserved.



Customer Card

3-1.

K:S

Dynamics 365 Business Central | 10000 - The Cannon Group PLC
& CUSTOMER CARD (7)) 4+ w
p o
New Document Request Approval Customer Actions
N
Taiwan Localization Setup - GUI b °
GUI with Shipment L @
Uniform Number 37935875
GUI Format Code 31
Invoice Title ‘ |
GUI Deliver Addr. Vv
\ v

Inform

Edit Customer Card to fill in the domestic customer’s Taiwan Uniform Number information.

Dynamics 365 Business Central | 10000 - The Cannon Group PLC
& CUSTOMER CARD (2 + W
gy
New Document Request Approval Customer Actions
UL WILTE STHPITIENnL b4
A“
Uniform Number 37935875
GUI Format Code 31
Invoice Title
GUI Deliver Addr.
GUI Summary Note Code ‘O2|
kGUl Summary Note Description 244 FIEE v )
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Purchase Procedure / Sales Procedure

4-1. Register the GUI No. Information from Purchase Invoice to GUI Module.

Dynamics 365 Business Central | Pur woices > 1001 - Fumiture Industries

7N
& PURCHASE INVOICE \fj + ]

1001 - Furniture Industries

Process Invoice Request Approval Incoming Document Actions Less options @
= Invoice v @ Release # Functions v = Posting Taiwan Localization - GUI ~ -
Lines Manage More options - Documents 0
o -
« o Incoming D t Files
SITE CODE GUI NO. TYPE , gt NO. g Locument kres
3 Comment
28853916 HR99751255 ftem 1964-5 NAME TYPE
28853916 HR99751255 ftem 1908-5

(There is nothing to show in this view)

Vendor Statistics

[andar ML AATCEANA

4-2.  You can decide to create Sales GUI No. from which process of Sales procedure.

(Sales Order / Warehouse shipment / Sales Invoice)

e @ http://d365be-wl-tw-ks/nav/Tcompany=My%20Com O = & || @ Edit - Sales Invoice - 1006 ...

Dynamics 365 Business Central
N
SALES INVOICE ( )
& Z) + o
Posting Prepare Invoice Release Request Approval Actions Navigate 0]
[> Release - # Functions 7 Predict Payment =+ Posting Taiwan Localization - GUI ~ <

<

-
- .
-_ Documents
-

-
° SITE CODE GUI NO. T\“ - NO.

| 28853916 i BB18090001 | G/L Account 6110 Customer Details
Customer No. 2001’..\‘
Phone No.
< > Email
Fax No.
Subtotal E... 1,000.00 Total Excl.. 1,000.00 Credit Limit (LCY) 0.
Inv. Discou... 0.00 Total VAT (... 50.00 Available Credit (LCY) 0]
v Payment Terms Code 14DAs V¥
1 H IaH o Tosoll 4 NCA AN AV
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GUI List

5-1.

5-2.

amics 365

GUI List

Business Central

GUI List

K

You can check the all GUI which has been registered to GUI Module from GUI List.

£ Search Process 38 Open in Excel Actions Less options =
Filter >
PERIOD PERIOD GUI GUI
POSTING OF ORDER OF TRANSACTIC DOCU
SITE CODE GUI NO. DATE DECLARATI  DATE TRANSACT  TYPE TYPE
28853916 AA18090001 2018/9/4 10711 2018/9/4 10709 SAL GuI™
28853916 AA18090001 2018/9/5 10711 2018/9/5 10709 SAL ALV
28853916 AA18090002 2018/9/7 2018/9/7 10709 SAL GUIv
< >

& <D

Inform

ynamics 365

Process

Page

Business Central

Actions

Navigate

Select what you want to action for existing GUI.

GUI List

Less options

()’( Void = Print GUI = Print e-GUI certification

)

Show more

General N
Site Code 28853916 Contact Mr. Andy Teal
GUI No. AA18090001 Summary Note Please reference Sales Order
End GUI No. Despriction
GUI Seq. 0 PRINT
e
GUI Foramt Code m W Print Count L
Period Of Declaration 10711 VoID \
Close
< >
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GUI MEDIA EXPORT

6-1. Lookup the Site Master in the Declaration Site field and enter which period GUI data you want to
export.

e “§= hitp://d365be-wl-tw-ks/nav/?comp O ~ € || o« Accountant - Dynamics 365...

Dynamics 365 Business Central

X Want more? Start a free art trial... v

EDIT - GUI MEDIA EXPORT /

X You can include Cortang | Don't ask again v

CRONUS Int¢ Declaration Site .?885,%‘)1(4 X ~| intv Cash >

Chart of Accoun  Period 10711 gev
Show Error Only @

ACTIONS Close Current Period @

—+ Sales Credit A

~+ Purchase Cre

> Taiwan Locali

> Payments

> Analysis

> Tasks s

chedule. oK Cancel

Activities

N iy it

6-1.  You can upload this file to National Taxation Bureau declaration system to complete your VAT
declaration.

e "é‘ http://d365be-wl-tw-ks/nav/7comp O = & r"é",".\ccm_mtav'n:— Dynamics 363...

Dynamics 365 Business Central
X Want more? Start a free, 30-day trial to unlock advanced features and use your own company data. ~ Start trial... v
X You can include Cortana Intelligence capabilities in the cash flow forecast. ~ Enable Cortana Intelligence | Don't ask again v
"
CRONUS Interrd 1 22253916 (1) - Notepad - O x
File Edit Format View Help
Chart of Accounts | | Ps@2sss39160e0000110709 28853916 20000000043220000000600
310288539160000002107093793587528853916A41809000100000000248010000000124
3302835391600000031076937935875288539164418096001006006001061060AE0AE05
318288539160000004107092478014728853916A41809000300000000020010000000010 A
310828853916000000510709247801472885391644180 12081 0
ACTIONS 350288539160000006107694117510128853916881809000100200000100010200000050
‘ 210283539160000007107092885391653740476HR99751255000000095000160000047501
~+ Sales Credit Meth| 3102885391 10789180 2885391641809000 8206206200 A
| | 358288539150000009107691809999923853916581809600 A
+ Purchase Credit
> Taiwan Localizaf
> Payments
> Analysis
> Tasks
Activities
g Vv
A stinsit
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